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CHAPTER 1

Introduction
A condition is a single-sourcing feature that you can apply to files or different areas of your content.
Conditions can determine whether certain information displays in some outputs but not in others.
You can also control whether content displays on a certain device or screen size.

Process

1. "Adding Condition Tag Set Files" on page 8

2. "Creating Conditions" on page 10

3. "Editing Conditions" on page 11

4. "Applying Conditions to Content" on page 12

5. "Associating Conditions With Targets" on page 44

Other Information

n "Conditions and Single-Sourcing" on page 54

n "Responsive Conditions" on page 55

n "Global Project Linking and Conditions" on page 67
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n "Conditions on Styles" on page 68

n "Conditions and File Reviews" on page 74

n "Conditions and Tracked Changes" on page 77

n "Exporting and Conditions" on page 78

n "Conditions With Mimic and Capture" on page 79

Other Activities

n "Opening Condition Tag Sets" on page 81

n "Importing Condition Tag Sets" on page 83

n "Renaming Condition Tag Sets" on page 84

n "Creating Basic and Advanced Tag Expressions" on page 85

n "Using Snippet Conditions" on page 100

n "Single-Sourcing Micro Content Using Conditions" on page 112

n "Associating Conditions to a File While Editing" on page 123

n "Removing References to Undefined Conditions" on page 126

n "Viewing Used Conditions" on page 131

n "Viewing Undefined Conditions" on page 133

n "Viewing Unused Conditions" on page 138
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CHAPTER 2

Process for Conditions
Certain tasks must be completed in order when using this feature.

This chapter discusses the following:

Adding Condition Tag Set Files 8

Creating Conditions 10

Editing Conditions 11

Applying Conditions to Content 12

Associating Conditions With Targets 44
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Adding Condition Tag Set Files
A condition tag set is used to hold condition tags you create for your project. Flare's factory
templates may provide you with an initial condition tag set, which contains different condition tags
(depending on which template you select) to help get you started. You can create as many
additional condition tags as you want for that condition tag set. However, if for some reason you
want more condition tag sets to hold even more condition tags, you can easily add them. Any
condition tag sets that you add can be used in the same project and in the same outputs (e.g., if you
have 18 condition tag sets, you can use conditions from all of those 18 condition tag sets in the
same output generated from a project).

A condition tag set file has an .flcts extension and is stored in the Project Organizer under the
Conditional Text folder.

How to Add a Condition Tag Set File
1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Condition Tag Set.

n Right-Click In the Project Organizer, right-click on the Conditional Text folder and from
the context menu select Add Condition Tag Set.

The Add File dialog opens.

2. In the File Type field at the top, make sure Condition Tag Set is selected.

3. In the Source area, choose to create the new file based on a template or an existing file.

n New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare Desktop,
expand the Factory Templates folder and click on a template file. If you want to use
your own custom template file, expand the appropriate folder and click on a file. For
more information about templates, see the Help system.

n New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click , use the Open File dialog to find a file, and
double-click it.
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4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click and select the subfolder. Otherwise,
keep the default location.

5. In the File Name field, type a new name for the condition tag set.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The condition tag set is added to the Conditional Text folder in the Project
Organizer. The Condition Tag Set Editor opens to the right, with the page for the new
condition tag set shown. Flare Desktop provides you with some condition tags to help get you
started.
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Creating Conditions
Within a condition tag set, you can create as many condition tags as you need.

How to Create a Condition
1. In the Project Organizer, expand the Conditional Text folder and double-click a condition tag

set.

If it is a new condition tag set, some condition tags may already be provided for you. Each
condition tag is associated with a color, making it easy to identify conditioned content in the
Flare Desktop interface.

2. In the Condition Tag Set Editor, click .

3. On the NewTag row, press F2 and give the condition a name.

You can also do any of the following:

RENAME A TAG

a. Click the tag row and press F2.

b. Type a new name and press ENTER.

CHANGE THE COLOR OF A TAG

a. Click the Background drop-down arrow and select Pick Color.

b. Select a new color and click OK.

ADD COMMENTS TO A TAG

You can add internal comments to indicate the purpose of a tag. Comments will not be
displayed in the output.

a. Click in the Comment cell of the tag row.

b. Press F2.

c. Type the comment and press ENTER.

4. Click to save your work.
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Editing Conditions
If necessary, you can edit the name, color, or comments for a condition tag that you have created.

How to Edit a Condition
1. In the Project Organizer, expand the Conditional Text folder.

2. Double-click the condition tag set holding the tag that you want to modify.

3. Do any of the following:

TO RENAME A CONDITION

a. Click the tag and press F2 on your keyboard. The tag name is highlighted.

b. Type a new tag name.

c. Press ENTER on your keyboard.

TO CHANGE THE COLOR OF A CONDITION

a. Click the Background drop-down arrow and select Pick Color. The Color Picker dialog
opens.

b. Select a new color.

c. Click OK.

TO CHANGE OR ADD COMMENTS FOR A CONDITION

a. Click in the Comment cell of the tag.

b. Press F2 on your keyboard.

c. Type comments for the tag.

d. Press ENTER on your keyboard.

4. Click to save your work.
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Applying Conditions to Content
After you create condition tags in a project, you can apply them to your content.

You can apply condition tags to many different elements in your project, such as files that make up
the project (e.g., topic, image, stylesheet, glossary, skin, target files), full paragraphs, text within
paragraphs, table rows and columns, table of contents (TOC) entries, glossary terms, index
keyword markers, and more.

How to Apply a Condition—Quick Steps
1. For most elements, you can right-click and select Conditions (or Properties > Conditional Text

for files).

2. Select the condition tag set and choose the condition(s) you want to apply and click OK.

3. Click to save your work.

How to Apply Conditions to Selected Text
Within a Paragraph

1. Open the content file.

2. Highlight the text to which you want to apply the condition tag.

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Home > Conditions.

n Keyboard Shortcut Press CTRL+SHIFT+C.

n Right-Click Right-click on the text and from the context menu select Conditions.

n Drag-and-Drop In the Project Organizer, open the Conditional Text folder and expand
the appropriate condition tag set. Click on the condition tag and drag it to the selected
text in the XML Editor. (You can apply only one condition at a time to text using this
method. However, you do not need to continue with any of the other steps below.)
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EXAMPLE — Selected Text

You want to apply a condition tag to selected text in a paragraph. First, in the
XML Editor you would select the text in question.

Then in the Project Organizer, you open the Conditional Text folder and expand
the appropriate condition tag set.
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Finally, you click on the condition tag and drag it to the selected text in the XML
Editor.

The Condition Tags dialog opens, with the first condition tag set selected and the associated
condition tags shown on the right.

4. If you want to see condition tags for a different condition tag set, select it.

5. For each condition tag that you want to apply to the text, click the check box next to the tag. A
check mark appears in the box.

6. Click OK.
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7. There are a couple of ways to tell whether a selection of text has one or more condition tags
applied to it. In the bottom local toolbar of the XML Editor, click either of the following two
toggle buttons to turn the tag indicators on and off.

Option Description

Click this button at the bottom of the XML Editor to show or hide shading of
the text itself. For example, if your condition tag has blue associated with it
and you click this button to show the indicator, the content becomes shaded
with a lighter version of blue. If more than one condition tag is applied to the
content, the shading appears in a pattern that shows all of the applied
condition tag colors.
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Option Description

You can turn off the condition toggle button mentioned above. Then make
sure this button (located at the bottom of the XML Editor) is enabled to show
or hide the span bar above the topic. When the cursor is in the paragraph
containing the applied tag, the span bar is shaded with a lighter version of
the tag color. This is a good feature to use if you find the shading of the
actual text distracting.

8. Click to save your work.

CHAPTER 2  16



How to Apply Conditions to an Entire Block of
Content
Topics usually contain several blocks of XML content. For example, there are HTML blocks, body
blocks, paragraph blocks, table blocks, and heading blocks. You can apply a condition tag to any
block of content in your topics.

1. Open the content file.

2. Click on the text to which you want to apply the condition tag. (There is no need to highlight
it.)

3. Do one of the following, depending on the part of the user interface you are using:

n Structure Bars

a. If the tag block bars are not shown to the left of the content, click at the
bottom of the editor.

b. Right-click on the tag bar for the block of content to which you want to apply the
condition tag.

c. In the context menu, select Conditions.

CHAPTER 2  17



n Ribbon Select Home > Conditions.

n Keyboard Shortcut Press CTRL+SHIFT+C.

n Right-Click Right-click on the text and from the context menu select Conditions.

n Drag-and-Drop/Structure Bars Click on the condition tag and drag it to the selected text
in the XML Editor.

a. If the tag block bars are not shown to the left of the content, click at the
bottom of the editor.

b. In the Project Organizer, open the Conditional Text folder and expand the
appropriate condition tag set.

c. Click on the condition tag and drag it to the structure bar representing that
paragraph in the XML Editor. (You can apply only one condition at a time to text
using this method. However, you do not need to continue with any of the other
steps below.)
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EXAMPLE — Structure Bars

You want to apply a condition tag to an entire paragraph, such as a heading in
a topic. First, in the Project Organizer, you open the Conditional Text folder and
expand the appropriate condition tag set.

Then you click on the condition tag and drag it to the structure bar representing
that paragraph in the XML Editor.
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Now let's say you want to apply a condition tag to content that contains a span
tag (i.e., a style to be used at the character level, rather than at the block level,
such as bold text).

First, in the XML Editor you would place your cursor somewhere in the
paragraph where the span tag has been applied.
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Then in the Project Organizer, you open the Conditional Text folder and expand
the appropriate condition tag set.

Finally, you click on the condition tag and drag it to the structure bar
representing the span tag in the XML Editor.

The Condition Tags dialog opens, with the first condition tag set selected and the associated
condition tags shown on the right.

4. In the context menu, select Conditions. The Condition Tags dialog opens, with the first
condition tag set selected and the associated condition tags shown on the right.

5. If you want to see condition tags for a different condition tag set, select it.

6. For each condition tag that you want to apply to the block of content, click the check box next
to the tag. A check mark appears in the box.

7. Click OK.
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8. There are two ways to tell whether a block of content has condition tags applied to it. In the
bottom local toolbar of the XML Editor, click one of the following toggle buttons to turn the
tag indicators on and off:

Option Description

Click this button at the bottom of the XML Editor to show or hide shading of
the text itself. For example, if your condition tag has blue associated with it
and you click this button to show the indicator, the content becomes shaded
with a lighter version of blue. If more than one condition tag is applied to the
content, the shading appears in a pattern that shows all of the applied
condition tag colors.
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Option Description

You can turn off the condition toggle button mentioned above. Then make
sure this button (located at the bottom of the XML Editor) is enabled to show
or hide the tag block bar to the left of the topic. The tag bar is shaded with a
lighter version of the tag color. This is a good feature to use if you find the
shading of the actual content distracting.

9. Click to save your work.
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How to Apply Conditions to Content or Project
Files
You can apply conditions to entire files in your project. This includes any file contained in the
Project Organizer (such as glossary or target files) or the Content Explorer (such as topic, image,
stylesheet, snippet, and page layout files). You can apply condition tags when you create an
element (i.e., in the Add File Dialog), or after the element has been created.

To Apply Conditions to Newly Created Files
1. Create a new file (e.g., topic, alias file, image). The Add File Dialog opens.

2. Expand the Attributes section at the bottom of the dialog.

3. If you want to apply condition tags to the file, expand the Attributes section at the bottom of
the dialog. Next to the Condition Tags field, click and select the conditions you want to
apply.

4. Click OK.

To Apply Conditions to One File at a Time
1. Open the Project Organizer or Content Explorer.

2. Locate the file to which you want to apply a condition tag. In the Project Organizer, files are
stored in various folders. In the Content Explorer, topic files are located by default at the top
level (unless you place them in subfolders that you’ve created); other files are traditionally
located in subfolders within the Resources folder, although they can be stored in custom
folders as well. For example, snippet files are usually located in a subfolder called "Snippets."

3. Right-click the file and from the context menu select Properties. The Properties dialog for the
file opens.

4. Click the Conditional Text tab. The first condition tag set is selected and the associated
condition tags are shown on the right.

5. If you want to see condition tags for a different condition tag set, select it.

6. For each condition tag that you want to apply to the file, click the check box next to the tag. A
check mark appears in the box.
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7. Click OK. The square next to the file name in the Project Organizer or Content Explorer now
takes on the color of the condition tag. If you applied more than one condition tag to the file,
each color is shown. (If you do not see squares, click in the local toolbar.)

To Apply Conditions to Multiple Content Files Using the
File List Window Pane

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > File List.

n Keyboard Shortcut Press CTRL+SHIFT+J.

The File List window pane opens.

2. (Optional) From the Filter list in the window pane, select the type of files to view.

3. Select the files to which you want to apply condition tags. You can hold the SHIFT key to
select a range, or you can hold the CTRL key to select individual items.

4. In the local toolbar, click . The Properties dialog opens.

5. Click the Conditional Text tab. The first condition tag set is selected and the associated
condition tags are shown on the right.

6. If you want to see condition tags for a different condition tag set, select it.

7. For each condition tag that you want to apply to the files, click the check box next to the tag.
A check mark appears in the box.

8. Click OK. The squares next to the file names in the File List window pane now take on the
color of the condition tag. If you applied more than one condition tag to the file, each color is
shown.
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To Apply Conditions to Multiple Project or Content Files
Using the Split View Feature

1. Open the Project Organizer or Content Explorer.

2. Click the Show Files button . The Project Organizer or Content Explorer splits into two
halves (left and right).

3. On the left side of the split Project Organizer or Content Explorer, select the folder containing
the files to which you want to apply condition tags.

4. On the right side of the split Project Organizer or Content Explorer, select the files. You can
hold the SHIFT key to select a range, or you can hold the CTRL key to select individual items.

5. In the toolbar click . The Properties dialog opens.

6. Click the Conditional Text tab. The first condition tag set is selected and the associated
condition tags are shown on the right.

7. If you want to see condition tags for a different condition tag set, select it.

8. For each condition tag that you want to apply to the files, click the check box next to the tag.
A check mark appears in the box.

9. Click OK. The square next to the file name in the Project Organizer or Content Explorer now
takes on the color of the condition tag. If you applied more than one condition tag to the file,
each color is shown in the square. (If you do not see squares, click in the local toolbar.)

10. To hide the split view, click the Show Files button again.

11. Click to save your work.
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How to Apply Conditions to a Bookmark
1. Open the content file.

2. Right-click on the bookmark.

NOTE If you cannot see the bookmark, make sure the markers are shown in the
topic. To turn markers on, click the down arrow next to the Show tags button in
the XML Editor. Then select Show Markers.

3. In the context menu, select Conditions. The Condition Tags dialog opens, with the first
condition tag set selected and the associated condition tags shown on the right.

4. If you want to see condition tags for a different condition tag set, select it.

5. For each condition tag that you want to apply to the bookmark, click the check box next to the
tag. A check mark appears in the box.

6. Click OK. A square with the color of the condition tag is displayed next to the bookmark.

7. Click to save your work.
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How to Apply Conditions to a Browse Sequence
Entry
You can include or exclude a specific browse sequence entry (book, topic, external link) from a
target.

1. Open the Project Organizer.

2. Expand the Advanced folder.

3. Double-click the browse sequence that you want to open. The Browse Sequence Editor opens
to the right.

4. Do one of the following:

DRAG AND DROP

This is the quickest method. However, you can only apply one condition at a time.

a. If the tag block bars are not shown to the left of the content, click at the bottom of
the editor.

b. In the Project Organizer, open the Conditional Text folder and expand the appropriate
condition tag set.

c. Click on the condition tag and drag it to the appropriate entry in the editor.

PROPERTIES DIALOG

This method is best for applying multiple conditions at the same time.

a. In the editor, select the entry to which you want to apply the tag.

b. In the local toolbar, click . The Properties dialog for the entry opens.

c. Click the Conditional Text tab. The first condition tag set is selected and the associated
condition tags are shown on the right.

d. If you want to see condition tags for a different condition tag set, select it.

e. For each condition tag that you want to apply to the entry, click the blank square next to
the tag. A check mark appears in the square.

f. Click OK.
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The square next to the browse sequence entry in the Browse Sequence Editor now takes on
the color of the condition tag. If you applied more than one condition tag to the browse
sequence entry, each color is shown in the square.

If you cannot see the squares next to the browse sequence entries, click in the local
toolbar to show the condition indicators.

5. Click to save your work.
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How to Apply Conditions to Glossary Terms
1. Open the Project Organizer.

2. Expand the Glossaries folder.

3. Double-click the glossary that you want to open. The Glossary Editor opens to the right.

4. Select the term. If you want to apply the same condition(s) to multiple terms, hold down your
SHIFT or CTRL key and select the terms.

5. In the local toolbar click . The Properties dialog opens.

6. Select the Conditional Text tab. The first condition tag set selected and the associated
condition tags are shown on the right.

7. If you want to see condition tags for a different condition tag set, select it.

8. For each condition tag that you want to apply to the entry, click the blank square next to the
tag. A check mark appears in the square.

9. Click OK. The Condition column indicates whether a term has conditions applied to it.

10. Click to save your work.
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How to Apply Conditions to an Image
1. Open the content file.

2. Right-click the image.

3. In the context menu, select Conditions. The Condition Tags dialog opens, with the first
condition tag set selected and the associated condition tags shown on the right.

4. If you want to see condition tags for a different condition tag set, select it.

5. For each condition tag that you want to apply to the image, click the check box next to the
tag. A check mark appears in the box.

6. Click OK. A square with the color of the condition tag is displayed next to the image.

7. Click to save your work.
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How to Apply Conditions to an Image Map
1. Open the content file.

2. Right-click the image containing the image map.

3. In the context menu, select Image Map.

4. Click on an object on the image (e.g., rectangle) being used as a link. In the local toolbar, click
. The Condition Tags dialog opens. (You can also open the Conditions dialog by selecting

Edit > Conditions or using the CTRL+SHIFT+C shortcut on your keyboard.)

5. If you want to see condition tags for a particular condition tag set, select it.

6. For each condition tag that you want to apply to that section of the image, click the check box
next to the tag. A check mark appears in the box.

7. Click OK. A square with the color of the condition tag is displayed on that section of the
image.

8. Click OK in the Image Map Editor.

9. Click to save your work.
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How to Apply Conditions to an Index Keyword
Marker

1. Open the content file.

2. In the XML Editor, right-click on the index keyword marker.

NOTE If you do not see the marker, click the Show tags drop-down arrow and
select Show Markers.

3. In the context menu, select Conditions. The Condition Tags dialog opens, with the first
condition tag set selected and the associated condition tags shown on the right.

4. If you want to see condition tags for a different condition tag set, select it.

5. For each condition tag that you want to apply to the index keyword marker, click the check
box next to the tag. A check mark appears in the box.

6. Click OK. A square with the color of the condition tag now displays next to the index marker in
the topic.

7. Click to save your work.
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How to Apply Conditions to a Link
1. Open the content file.

2. Make sure the span bars are visible at the top of the XML Editor. If they are not, click at the
bottom of the local toolbar to show them.

3. Right-click on the span bar above the topic that corresponds with the link.

NOTE If you first click on the link in the topic, the corresponding span bar is
highlighted above. For hypertext links, the span bar is labeled "a." For cross-
references, the span bar is labeled "MadCap:xref."

4. In the menu, select Conditions. The Condition Tags dialog opens, with the first condition tag
set selected and the associated condition tags shown on the right.

5. If you want to see condition tags for a different condition tag set, select it.

6. For each condition tag that you want to apply to the link, click the check box next to the tag. A
check mark appears in the box.

7. In the Exclude Action section, select one of the options.

n Remove Deletes the link text from the output.

n Unbind Removes the link from the content in the output, but leaves the text.
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EXAMPLE You are creating both online and PDF output from your project. You
might have some content where you have inserted hyperlinks, and you want
this content to be included in both the online and PDF output. However, let's
say that a particular hyperlink connects to another topic that you are not
including in the PDF. When you generate the online output, everything is fine.
But when you generate the PDF, an error is displayed in the log because the
compiler cannot find the topic referenced in the hyperlink.

The way to avoid seeing the error (and to avoid users experiencing a broken
link in the output) is to apply a condition tag (e.g., "OnlineOnly") to the hyperlink
and select the option in the dialog to unbind the link. If you then exclude that
condition tag from your print target, you will still see the hyperlink text in the
PDF, but the link will be removed. Therefore, you will no longer receive an error
and the link will not be broken.

8. Click OK.

9. Click to save your work.
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How to Apply Conditions to aMicro Content
Phrase

1. From the Content Explorer, find and open the micro content file.

2. On the left side of the Micro Content Editor, right-click a phrase, and from the context menu
select Properties. (Alternatively, you can select the phrase and click in the local toolbar or
press F4.)

3. In the Properties dialog, select the Conditional Text tab. The first condition tag set is selected
and the associated condition tags are shown on the right.

4. If you want to see condition tags for a different condition tag set, select it.

5. For each condition tag that you want to apply to the file, click the check box next to the tag. A
check mark appears in the box.

6. Click OK. The square next to the file name in the Micro Content Editor now takes on the color
of the condition tag. If you applied more than one condition tag to the file, each color is
shown. (If you do not see squares, click in the local toolbar.)
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How to Apply Conditions to a Slideshow
1. Open the content file.

2. If the tag block bars are not shown to the left of the content, click at the bottom of the
editor.

3. Right-click on the tag bar for the slideshow to which you want to apply the condition tag. If
you want to apply the tag to the entire slideshow, select the MadCap:slideshow bar. If you
want to apply the tag to a specific slide, select the Slide bar.

4. In the context menu, select Conditions. The Condition Tags dialog opens, with the first
condition tag set selected and the associated condition tags shown on the right.

5. If you want to see condition tags for a different condition tag set, select it.
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6. For each condition tag that you want to apply to the slideshow, click the check box next to the
tag. A check mark appears in the box.

7. Click OK.

8. There are two ways to tell whether a slideshow has condition tags applied to it. In the bottom
local toolbar of the XML Editor, click one of the following toggle buttons to turn the tag
indicators on and off:

Option Description

Click this button at the bottom of the XML Editor to show or hide shading of
the text itself. For example, if your condition tag has blue associated with it
and you click this button to show the indicator, the content becomes shaded
with a lighter version of blue. If more than one condition tag is applied to the
content, the shading appears in a pattern that shows all of the applied
condition tag colors.
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Option Description

You can turn off the condition toggle button mentioned above. Then make
sure this button (located at the bottom of the XML Editor) is enabled to show
or hide the tag block bar to the left of the topic. The tag bar is shaded with a
lighter version of the tag color. This is a good feature to use if you find the
shading of the actual content distracting.

9. Click to save your work.
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How to Apply Conditions to a Snippet
1. Open the content file.

2. Right-click on the snippet.

3. In the context menu, select Conditions. The Condition Tags dialog opens, with the first
condition tag set selected and the associated condition tags shown on the right.

4. If you want to see condition tags for a different condition tag set, select it.

5. For each condition tag that you want to apply to the snippet, click the check box next to the
tag. A check mark appears in the box.

6. Click OK. The color of the condition tag is applied to the snippet.

7. Click to save your work.

NOTE Not only can you apply a condition tag to a snippet, but you can also create snippet
conditions. Snippet conditions are just regular condition tags that you can apply to content
within snippets and then include or exclude them at the snippet or topic level (rather than at
the target level). They are especially useful when the majority of the snippet content is
identical everywhere the snippet is used, but there are some small differences in some
places. This lets you use one snippet for many purposes, rather than having to create
multiple snippets to account for the small exceptions. See "Using Snippet Conditions" on
page 100.

CHAPTER 2  40



How to Apply Conditions to a TOC Entry
You can include or exclude a specific TOC entry (book, topic, external link) from a target.

1. Open the Project Organizer.

2. Expand the TOCs folder.

3. Double-click a TOC. The TOC Editor opens to the right.

4. Do one of the following:

DRAG AND DROP

This is the quickest method. However, you can only apply one condition at a time.

a. If the tag block bars are not shown to the left of the content, click at the bottom of
the editor.

b. In the Project Organizer, open the Conditional Text folder and expand the appropriate
condition tag set.

c. Click on the condition tag and drag it to the appropriate entry in the editor.

PROPERTIES DIALOG

This method is best for applying multiple conditions at the same time.

a. In the editor, select the entry to which you want to apply the tag.

b. In the local toolbar, click . The Properties dialog for the entry opens.

c. Click the Conditional Text tab. The first condition tag set is selected and the associated
condition tags are shown on the right.

d. If you want to see condition tags for a different condition tag set, select it.

e. For each condition tag that you want to apply to the entry, click the blank square next to
the tag. A check mark appears in the square.

f. Click OK.
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The square next to the TOC entry in the TOC Editor now takes on the color of the condition
tag. If you applied more than one condition tag to the TOC entry, each color is shown in the
square.

If you cannot see the squares next to the TOC entries, click at the bottom of the local
toolbar to show the condition indicators.

5. Click to save your work.

IMPORTANT Placing a condition on a TOC or browse sequence entry does not remove the
linked file from online output. In order to prevent a topic from being found in the output
(e.g., via search or context-sensitive Help), you must place the condition on the topic file
itself.
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How to Apply Conditions to a Variable
1. Open the content file.

2. Right-click on the variable.

3. In the context menu, select Conditions. The Condition Tags dialog opens, with the first
condition tag set selected and the associated condition tags shown on the right.

4. If you want to see condition tags for a different condition tag set, select it.

5. For each condition tag that you want to apply to the variable, click the check box next to the
tag. A check mark appears in the box.

6. Click OK. A square with the color of the condition tag is displayed next to the variable.

NOTE If you cannot see the colored box, make sure the markers are shown in the
topic. To turn markers on, click the down arrow next to the Show tags button in
the XML Editor. Then select Show Markers.

7. Click to save your work.

What’s Noteworthy?

NOTE You can quickly see how a topic (as well as a snippet or template page) will look in
the final output by previewing it. The Preview window pane is dynamic, allowing you to keep
the preview open while you work and see changes as you make them in the XML
Editor. When you use the preview feature, you can select any target in your project. The
topic will be previewed with the condition tag settings from that target. You can quickly see
what the topic looks like with certain condition tags included and others excluded.
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Associating Conditions With Targets
After creating and applying conditions, you need to tell Flare Desktop what your target should do
with those conditions. Should content with a particular condition tag be included in or excluded
from that target, or should it display only when viewed on a certain device or screen size?

How to Associate Conditions With a Target
1. Open the Project Organizer.

2. Expand the Targets folder.

3. Double-click a target. The Target Editor opens to the right.

4. Click the Conditional Text tab.

5. In the Condition Tag Sets area, you can choose to view tags for all condition tag sets or you
can select a specific set. The tags associated with the selected set are shown to the right,
with their associated colors. An Action cell appears next to each condition tag. When Basic is
selected, the Action cell is shown and the Advanced section below is disabled. In the Tags
area, select a condition tag in the grid to set its action. (You can also hold down the SHIFT or
CTRL key and choose multiple rows to set the same action on all of them at once.)

6. The Action cell in the grid indicates the current setting for the condition. The text is gray if you
have not explicitly chosen an option. To change the setting, choose one of the options in the
area to the right.
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ACTION OPTIONS
n Not Set If an action is not set on a condition, its behavior may vary (i.e., it might be

included or excluded). This depends on whether or how you have set other conditions.

n Include Select this if you want the content associated with the condition to always
display in the target’s output.
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n Exclude Select this if you want the content associated with the condition to never
display in the target’s output.

n Display by Media Query Select this if you are working in an HTML5 target and want the
content associated with the condition to display only when the user is viewing the
output on a particular device or screen size (according to the responsive output
breakpoints that are set in the target or skin).

After selecting this option, choose one or more of the media query check boxes. The
Active cell in the grid updates accordingly.
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l Web The content will display if the user is viewing it on a large screen.
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l Tablet The content will display if the user is viewing it on a medium screen, such as
an iPad.
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l Mobile The content will display if the user is viewing it on a small screen, such as an
iPhone.

BASIC AND ADVANCED CONDITIONS

When you create condition tag expressions, you have the choice of working with conditions in
Basic or Advanced mode. You can switch between the two modes by clicking Basic or
Advanced toward the bottom of the interface. You can use Basic if you are newer to condition
tag expressions, or you can use the Advanced mode if you are experienced at writing
condition tag expressions by hand. While the Basic section is easier for most people to use, it
is also more limited in the type of expressions it can create.
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WARNING The condition feature is an inclusive system. If you do not select any
options, all of the tags will automatically be included, as indicated by the gray text in
the Action cell. If you include only some tags and exclude others, any remaining tags
without options specifically set will automatically be included. However, if you select
Include for any of the tags (even just one) and do not select Exclude for any tags, all
of the other tags that do not have the Include option set explicitly will automatically
be excluded. If you have not explicitly set an option for a condition tag, make sure you
look at the gray text in the Action cell to know what will happen for that tag in the
output.
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7. Click to save your work.

CHAPTER 2  51



NOTE When you generate the target, Flare Desktop uses the expression from the section
that is last saved—Basic or Advanced.
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CHAPTER 3

Other Information for
Conditions
In addition to the primary concepts, there is some additional information that might help you when
working with this feature.

This chapter discusses the following:

Conditions and Single-Sourcing 54

Responsive Conditions 55

Global Project Linking and Conditions 67

Conditions on Styles 68

Conditions and File Reviews 74

Conditions and Tracked Changes 77

Exporting and Conditions 78

Conditions With Mimic and Capture 79
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Conditions and Single-Sourcing
Single-sourcing means to produce multiple results from one source. In Flare Desktop, you can
make use of single-sourcing in many different ways.

One way to single-source content is to take advantage of multiple output formats and condition
tags. How does it work? Each target in your project is a potential output (using a specific output
format, such as HTML5 or PDF). You can create and apply condition tags to content. Then you
associate the condition tags to your different targets as necessary, so that some content appears
in some targets but not in other targets. This way, you do not need to create a separate project for
each output that you want to produce. If most of the content for your outputs is similar, there is no
need to rewrite it in another project. Simply specify which sections to include or exclude in which
targets through the use of condition tags. This is one reason that topic-based authoring is so
appealing. By placing condition tags on individual topic files themselves, you can pick and choose
which topics to include in some outputs and which to include in other outputs.

EXAMPLE You need to create two PDFs from your project—one for beginning users and
another for advanced users. Rather than creating two separate projects, you can put all of
the content into a single project.

Then you can create one condition tag called "Beginner Manual" and another condition tag
called "Advanced Manual."

After that, you can apply the "Beginner Manual" condition tag to the content that belongs
only in the manual for beginners, and you can apply the "Advanced Manual" condition tag to
the content that belongs only in the manual for advanced users.

Finally, you open one PDF target and tell Flare Desktop to include the "Beginner Manual"
condition tag and exclude the "Advanced Manual" condition tag. In the other PDF target,
you do the opposite; exclude the "Beginner Manual" condition tag and include the
"Advanced Manual" condition tag.
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Responsive Conditions
For HTML5 targets, conditions can be used to make content responsive (e.g., content changes
automatically according to the size of the screen, rather than simply based on “include” or
“exclude”). Associating conditions with factory media queries (Web, Tablet, Mobile) can help make
some content more appropriate or easier to read on different devices.

Features and User Interface Areas Affected
In addition to using this feature in targets, it can also be accessed when working in other areas of
the user interface. Following are the features for which you can and cannot set conditions to
display by media query:

Can Set by Media Query Cannot Set by Media Query

n Target Editor

n XML Editor

n Preview

n Review Wizard

n Export Project Wizard

n Snippet Conditions

n Import Flare Project Wizard and Editor

Limitations
Keep the following in mind if you intend to display conditioned content according to media queries:

n This feature does not support all outputs. It works only for HTML5 targets.

n Only factory media queries (Web, Tablet, Mobile) are supported and are controlled by the
breakpoints specified in the skin or target. This feature does not support custom media
queries.

n Only conditions applied to content are supported. This feature does not support conditions
that are applied to folders and files.
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How to Set Conditions by Media Query
Following are steps for setting conditions by media query in the Target Editor. The steps are similar
if you are working in the XML Editor, Preview window, or Send Files for Review Wizard; the first few
steps would vary, depending on the part of the user interface. For links to each full set of steps, see
"Features and User Interface Areas Affected" on the previous page.

1. Open an HTML5 target.

2. Click the Conditional Text tab.

3. Toward the bottom of the tab, make sure the Basic option is selected.

4. In the Condition Tag Sets area, you can choose to view tags for all condition tag sets or you
can select a specific set. The tags associated with the selected set are shown to the right,
with their associated colors. An Action cell appears next to each condition tag. When Basic is
selected, the Action cell is shown and the Advanced section below is disabled. In the Tags
area, select a condition tag in the grid to set its action. (You can also hold down the SHIFT or
CTRL key and choose multiple rows to set the same action on all of them at once.)

CHAPTER 3  56



5. The Action cell in the grid indicates the current setting for the condition. The text is gray if you
have not explicitly chosen an option. Select Display by Media Query. Then choose any of the
options below it.

n Web The content will display if the user is viewing it on a large screen.
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n Tablet The content will display if the user is viewing it on a medium screen, such as an
iPad.
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n Mobile The content will display if the user is viewing it on a small screen, such as an
iPhone.

NOTE If you select all three of the media query check boxes, it has the same effect
as choosing the “Include” option.

NOTE The “Display by Media Query” option is not available unless you are working in
an HTML5 target. Other target types do not show this option.
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NOTE The Basic method is the easiest way to display conditions by media query.
However, you can also use the Advanced method. If you choose to do so, the markup
should look something like the following.

6. Click to save your work.
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EXAMPLE You are writing documentation for a cloud-based product, where it is more
appropriate to tell users to “click” an option if they are working on a large screen, but to
“tap” the option if they are using a tablet or smart phone.

So in a condition tag set, you create three new conditions—one for each of those screen
sizes.

You write a procedure where you need to use to tell users to click or tap something.
Therefore, you add both words to the instructions.
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Then you apply the condition you named “Web” to the word “click,” and you apply the
“Tablet” and “Mobile” conditions to the word “tap.”
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You anticipate that you will need to use these words many times throughout the project, so
you create snippets—one holding the uppercase pair of words, and the other holding the
lowercase pair. That way, you can just insert the appropriate snippet wherever those words
are needed, rather than applying the conditions to text each time.

Next, you open the target and associate each of these conditions with the appropriate
media query.
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When you generate the online output and view it on a large screen, the word “click” is used.
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But when you view the output on a smaller tablet or mobile screen, the word “tap” is used.

What’s Noteworthy?

NOTE You can set responsive conditions on tables. However, if you also have a table
stylesheet applied to the table, responsive conditions only work if they are set on the entire
table (i.e., the <table> tag); they do not work if the conditions are set on individual rows,
columns, or cells.
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Global Project Linking and Conditions
With Global Project Linking, you can import content and project files contained in another Flare
project, thus allowing you to maintain the information in one location but reuse it in any other
project.

In addition to specifying certain files or file types to include or exclude from the import, you can go
a level deeper through the use of condition tags. If you have applied condition tags to files in your
project, you can use the Import Conditions field to tell Flare Desktop to include or exclude certain
files, depending on the condition tags that are applied to them at the file level. Simply click the Edit
button to choose the conditions. In the Conditional Text dialog for this feature, you can use the
Basic or Advanced mode for creating condition tag expressions.
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Conditions on Styles
Normally you would apply a condition to a piece of content or a file. But in Flare Desktop you can
also set conditions on styles and then apply those styles to content. This is simply another
alternative and might be more efficient for some authors. You might even find that you use both
methods in your projects. See and .

In the Advanced view of the Stylesheet Editor , you can associate a condition with a style by using
the mc-conditions property. If you are viewing properties by group (rather than alphabetically) in the
Stylesheet Editor, you can find this property in the Unclassified group.
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EXAMPLE You have created a lot of drop-downs throughout your project. But you want the
heading portion of the drop-down to display only in online outputs, not in any print-based
outputs.
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Of course you can manually apply conditions to your drop-down headings, but you would
have to do that each time you create a drop-down. A better option is to apply a condition to
the style used for the drop-down headings.

So you open your stylesheet and select the MadCap|dropDownHead style. And then in the
mc-conditions property you select a condition that you've created for the purpose of online
only outputs.
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As a result, the online only condition will automatically be applied to any drop-downs you've
created in the past, and any that you create in the future.
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So when you build online output, you will see this:

CHAPTER 3  72



And when you build print-based output, you will see this:

NOTE Conditions that are set locally (i.e., directly on content) will override conditions set
on a style. Even if the local condition is empty, it still overrides the conditions set from
stylesheet.

NOTE When you set a condition tag on a style, you can optionally use the mc-exclude-
action property to set an exclude action on the tag. For example, you might have the unbind
action for a condition tag if you have applied the tag to a hyperlink and want the link to be
removed from the text in some outputs, but you still want the text to be shown in those
outputs.
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Conditions and File Reviews
If you are using MadCap Contributor for topic reviews, you can include or exclude content in those
files based on condition tags.

After choosing the files in the wizard and selecting Send a review package file, you can click
toward the bottom of the page. The Conditional Text dialog opens.

You can include or exclude conditions in a couple of different ways, or even use both:

n Target Settings The easiest method is to click the Target Expressions drop-down and select a
target in your project. The dialog is automatically populated based on the included and
excluded conditions in that target.

n Manual You can also complete this dialog manually, using the same steps that are used in
the target for including and excluding certain condition tags.

EXAMPLE You have a topic that looks like this, with four different conditions applied to
content:
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In the Conditional Text dialog accessed from the Send Files For Review Wizard, you select
Target Expressions and choose User-Guide-A.
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When the reviewer opens the file, this is what is shown:

NOTE If you have already associated conditions with a file while editing in the XML Editor,
those settings are preserved when you open the Send Files For Review Wizard.
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Conditions and Tracked Changes
If you are tracking changes in Flare Desktop and make changes to your condition tags, you can
preserve the tracked changes in Word output.

NOTE You can see tracked changes to condition tags in PDF output if you enable change
bars. However, condition changes are not explicitly marked in the output, and could be
missed if there are other changes to the paragraph that would also enable a change bar.
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Exporting and Conditions
You can export project files and content based on conditions that you create. One reason you might
want to use this feature is to quickly and easily make a copy of projects and archive them,
especially if you have an extremely large Flare project and need to archive only parts of it. Another
use for this feature is translation. If you only need a portion of a parent project to be translated, you
don't want to send the translator all of the files, but rather a smaller version of the project
containing only the files requiring translation. For more information on this feature, see the Help
system.
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Conditions With Mimic and Capture
If you are also using MadCap Mimic or Capture (or both), you can use condition tags that exist in
your Flare project. This is similar to the variable integration that exists with these products.

EXAMPLE You have created two condition tags in a Flare project in order to send parts of
your content to different outputs—one condition tag called "Beginner" and the other called
"Advanced."

Now suppose you insert an image into that Flare project and then open the image in
Capture in order to edit it. Because you inserted the image into the project, a connection
already exists between the Flare project and the image while you work on it in Capture.

This means that if you attempt to apply condition tags to the image while it is in Capture,
you will have access to the "Beginner" and "Advanced" condition tags that you created in
the Flare project.

For more information see the Help system provided with Mimic and Capture.
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CHAPTER 4

Other Activities for Conditions
In addition to the main activities, there are some other tasks you might perform regarding this
feature.

This chapter discusses the following:

Opening Condition Tag Sets 81

Importing Condition Tag Sets 83

Renaming Condition Tag Sets 84

Creating Basic and Advanced Tag Expressions 85

Using Snippet Conditions 100

Single-Sourcing Micro Content Using Conditions 112

Associating Conditions to a File While Editing 123

Removing References to Undefined Conditions 126

Using Conditions to Unbind Links 129

Viewing Used Conditions 131

Viewing Undefined Conditions 133

Viewing Unused Conditions 138
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Opening Condition Tag Sets
When you want to modify an existing condition tag, use the following steps to open the condition
tag set.

How to Open a Condition Tag Set From the
Quick Launch Bar
The Quick Launch bar lets you search for any Flare Desktop file or command. It is located in the
upper-right corner of the interface. You can press CTRL+Q on your keyboard to move focus to the
Quick Launch bar so you can begin typing.

1. In the Quick Launch bar, type a few letters of the name of the file you want to open. Any
available results appear in a drop-down list.

2. From the list, click the name of the file.
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How to Open a Condition Tag Set From the
Project Organizer

1. Open the Project Organizer.

2. Double-click the Conditional Text folder. The condition tag sets in your project are displayed.

3. Double-click the condition tag set that you want to open. The Condition Tag Set Editor opens
to the right, with the tag set page shown.
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Importing Condition Tag Sets
Not only can you add a new condition tag set, but you can also import an existing condition tag set
(FLCTS file).

How to Import a Condition Tag Set
1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Condition Tag Set.

n Right-Click In the Project Organizer, right-click on the Conditional Text folder and from
the context menu select Add Condition Tag Set.

The Add File dialog opens.

2. In the File Type field at the top, make sure Condition Tag Set is selected.

3. Select New from existing and click .

4. Find and select the FLCTS file that you want to import.

5. Click Open. The Source File field now contains the path to the file that you are importing. Also,
the name of the file is displayed in the File Name field.

6. If you want to give the condition tag set a different name than that for the imported file, click
in the File name field and replace the text.

7. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

8. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

9. Click Add. The condition tag set is added and opens in the Condition Tag Set Editor.
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Renaming Condition Tag Sets
A condition tag set is used to hold condition tags you create for your project. Flare Desktop
provides you with an initial condition tag set, which contains some condition tags to help get you
started. You can rename the default condition tag set or any others that you add to your project.

How to Rename a Condition Tag Set
1. Open the Project Organizer.

2. Double-click the Conditional Text folder. The condition tag sets in your project are displayed.

3. Click on the condition tag set that you want to rename.

4. Press F2 on your keyboard. The condition tag set name is highlighted.

5. Type a new name for the condition tag set and press ENTER.

6. If your file contains links to other files, you will be asked if you want to retain those links. If so,
click Update Links.
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Creating Basic and Advanced Tag
Expressions

Supported In:

You can create tag expressions (i.e., instructions for including or excluding conditions) when
performing any of the following tasks:

n Associating Conditions to a File While Editing

n Associating Conditions With Targets

n Exporting Projects

n Global Project Linking—Importing Files From Other Projects

n Previewing Topics

n Reimporting Files From Other Projects

n Sending Files for Review in Contributor or Flare Desktop

n Using Snippet Conditions

NOTE Most of these tasks have to do with condition tags. However, when exporting
projects, you can also create expressions based on file tags. The process for creating file
tag expressions is essentially the same as that for condition tag expressions. The following
information describes condition tag expressions, but you can simply substitute file tags
wherever condition tags are mentioned.

When you create tag expressions, you have the choice of working with conditions in Basic or
Advanced mode. You can switch between the two modes by clicking Basic or Advanced in the user
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interface. You can use Basic if you are newer to condition tag expressions, or you can use the
Advanced mode if you are experienced at writing condition tag expressions by hand.  While the
Basic section is easier for most people to use, it is also more limited in the type of expressions it
can create.

With the Basic method, all of your work is done in the top half of the user interface, by just selecting
options. On the other hand, with the Advanced method, most of your work is done in the bottom
portion of the user interface by manually entering text.

TIP If you are an experienced user and want to use the Advanced mode, you might find it
helpful to begin with the Basic mode to create the initial expression and then switch to
Advanced when you are ready.

The following instructions are based on the task Associating Conditions With Targets, but the same
principles apply to the other tasks. The only real difference is that this task affects the content that
is included in the output. For example, the Previewing Topics task does not affect the output; it is
merely a way to see temporarily how different condition tag settings would change a particular
topic. And the Global Project Linking tasks affect which files are imported into a project, based on
condition tag settings.
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Instructions for Basic Conditions
In the Condition Tag Sets area, you can choose to view tags for all condition tag sets or you can
select a specific set. The tags associated with the selected set are shown to the right, with their
associated colors. An Action cell appears next to each condition tag. When Basic is selected, the
Action cell is shown and the Advanced section below is disabled. In the Tags area, select a
condition tag in the grid to set its action. (You can also hold down the SHIFT or CTRL key and
choose multiple rows to set the same action on all of them at once.)

The Action cell in the grid indicates the current setting for the condition. The text is gray if you have
not explicitly chosen an option. To change the setting, choose one of the options in the area to the
right.
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EXAMPLE You have two condition tags—one called "Beginner" and another called
"Advanced." Let's say that you have a topic containing three paragraphs. You apply the
Advanced tag to the first two paragraphs, and you apply the Beginner tag to the last two
paragraphs.

You have created a target called "Advanced Set Up." For this target, you obviously want to
include all content associated with the Advanced tag, but you want to exclude content
associated with the Beginner tag.

By default, Flare Desktop will include content associated with both tags, unless you tell it
not to. So you tell Flare Desktop to exclude the content associated with the Beginner tag.
The problem is the middle paragraph from the topic mentioned above. It is associated with
both tags. You have told Flare Desktop to exclude content associated with the Beginner
tag, and it will do so, overriding the default. But you want to make sure that paragraph is
included in the "Advanced Set Up" output. That is why you need to make sure you select the
Include option next to the Advanced tag.
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When you select options in the Basic section, you are creating expressions with "or" statements
(e.g., "include this condition tag or that one"). And when you do this, you can see the resulting
expression displayed in the Advanced section below.

Inclusive System for Including and Excluding
Conditions
The condition feature is an inclusive system. If you do not select any options, all of the tags will
automatically be included, as indicated by the gray text in the Action cell. If you include only some
tags and exclude others, any remaining tags without options specifically set will automatically be
included. However, if you select Include for any of the tags (even just one) and do not select Exclude
for any tags, all of the other tags that do not have the Include option set explicitly will automatically
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be excluded. If you have not explicitly set an option for a condition tag, make sure you look at the
gray text in the Action cell to know what will happen for that tag in the output.
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Instructions for Advanced Conditions
If you are a more experienced user, you may decide to use the Advanced section to write
expressions manually, rather than clicking options. You can type the names of the condition tags as
well as any of the following tokens: OR, AND, NOT, (). This lets you produce more complex, robust
expressions to control your output (i.e., "and" statements, as well as "or" statements).

Copy From Basic
When you select Advanced for the first time, the Basic section becomes disabled (i.e., the options
are disabled), and the Advanced section is enabled but empty (even if you've previously selected
conditions in the Basic section). However, you can copy the expression from the Basic section to
the Advanced section. This is a quick and easy way to create an initial expression and then adjust it
with "and" statements.
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Double-Click Tags
Another trick you can use while working in the Advanced section is to double-click any tag from the
Basic section. This adds the condition to the Advanced section so you do not have to type it. Just
make sure your cursor has been placed in the Advanced section before double-clicking a condition
tag. If you don't click in the Advanced section first, the newly added condition tag might overwrite text
you've entered previously in the Advanced section.

CHAPTER 4  92



CHAPTER 4  93



Warning Icon
When you type in the Advanced section, a yellow warning icon displays with relevant text if you
have typed an error.

You can expect to see this icon quickly appear and then disappear as you type. However, if the icon
remains after you finish, you can click it. The error will then be highlighted in the text below.
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Examples of Condition Expressions
Following are some examples of condition expression strings.

EXAMPLE — or

include [Primary.AllPrint or Primary.Website]

This is a simple expression that includes content that has either AllPrint or Website
conditions applied to it.

So let's say you have a topic that looks like this.

In the output, you will see this.
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EXAMPLE — and

include [Primary.AllPrint and Primary.Website]

This expression includes content that has AllPrint and Website conditions applied to it.
However, the output can also include other conditions not listed in the expression, since they
are not explicitly excluded.

So let's say you have a topic that looks like this.

In the output, you will see this.

Notice that the second sentence is included even though it contains not only the AllPrint
and Website conditions, but also the PDFA and PDFB conditions.
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EXAMPLE — and/and not

include [Primary.AllPrint and Primary.Website and not
Primary.PDFA]

This expression includes content that has AllPrint and Website conditions applied to it. In
addition, it specifically excludes content with the PDFA condition.

So let's say you have a topic that looks like this.

In the output, you will see this.

The second sentence with both Website and AllPrint does not display in the output because
the PDFA condition is in that sentence too, and it was set to be excluded via the "and not"
token.
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EXAMPLE — and not (and)

include [Primary.Website and not(Primary.AllPrint and
Primary.PDFB)]

This expression includes any content with the Website condition applied to it. In addition, it
specifically excludes content with both the AllPrint and PDFB conditions.

So let's say you have a topic that looks like this.

In the output, you will see this.

The sentence that had both the AllPrint and PDFB conditions was excluded. However,
another sentence that has the Website and PDFB conditions was included. That's because
the exclusion only occurs if both the AllPrint and PDFB conditions have been applied to the
sentence.
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What’s Noteworthy?

WARNING When you switch between the Basic and the Advanced view, your work is
preserved independently in both. However, be cautious when using the copy button.
Because of the way this feature is designed, it is a best practice to use either the Basic
section or the Advanced section in the long term, but not both. Although it is possible to
copy expressions from the Basic to the Advanced section, and this can save you lots of
time, you should not try to switch between sections over time. The reason for this is that
every time you make changes in the Basic section and click the button to copy the
expression to the Advanced area, your previous advanced expression will be overwritten.

NOTE When you generate the target, Flare Desktop uses the expression from the section
that is last saved—Basic or Advanced.
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Using Snippet Conditions
Snippet conditions are just regular condition tags that you can apply to content within snippets and
then include or exclude them at the snippet or topic level (rather than at the target level). They are
especially useful when the majority of the snippet content is identical everywhere the snippet is
used, but there are some small differences in some places. This lets you use one snippet for many
purposes, rather than having to create multiple snippets to account for the small exceptions.

How to Use Snippet Conditions
1. Create all of the condition tags that you plan to use for separating your snippet content.

TIP You might want to include the word "Snippet" somewhere in the name of a new
snippet condition tag (e.g., Snippet1, Snippet2). This way, you can easily identify it,
rather than confusing it with the rest of the condition tags that you use for other
purposes (e.g., online output or printed output condition tags).

NOTE The more variations that you have in your snippet content, the more condition
tags you will need to create. An average number is four to eight condition tags, but
you may find that you require fewer or more tags than this for snippet content. It is
always preferable to create more condition tags than you may need, rather than to
realize later that you have too few. You can even create a separate condition tag set
to be used specifically for holding your snippet condition tags, while keeping the rest
of your condition tags in other tag sets.

2. Create and open the snippet.

3. Apply the necessary condition tags to the text or other content in the snippet.

TIP It is a good idea to click the Hide/Show Conditional Indicators button at the
bottom of the editor so that you can clearly see where the different tags have been
applied in the snippet.
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4. Do one of the following.

TO APPLY SNIPPET CONDITIONS AT THE SNIPPET LEVEL

This method is recommended in most cases. It allows you more flexibility and tends to be
easier to maintain topics as time goes by. Snippet conditions at the snippet level override
snippet conditions applied at the topic level.

a. Insert the snippet into the topic, or determine which topic already contains the snippet.

b. In the topic, right-click the snippet, and from the context menu, select Snippet
Conditions. The Snippet Conditions dialog opens.

c. If you want to exclude a condition tag from the snippet, select its row to highlight it.
Then click the Exclude option to the right. If you want to include a condition in the
snippet, select its row to highlight it, then click the Include option to the right.

d. Click OK.

e. (Optional) Repeat steps b-d for any other instances of the snippet in the topic.

f. Click to save your work.

TO APPLY SNIPPET CONDITIONS AT THE TOPIC LEVEL

This method is good if you have snippet conditions set throughout a topic and you want to
include and exclude the same conditions for the entire topic. Otherwise, it is recommended
that you apply snippet conditions at the snippet level.

a. Insert the snippet into the topics, or determine which topics already contain the
snippet.

b. After you determine that a particular topic should display only certain tagged content
from the inserted snippet, open the Content Explorer and select the topic file.

NOTE If there are several topics that you know in advance will include a
particular snippet condition tag, you can open the File List window pane (View
> File List) instead and select all of those files at the same time.

c. In the local toolbar, click . The Properties dialog for the topic opens.

d. Click the Snippet Conditions tab.
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e. If you want to exclude a condition tag from the topic, select its row to highlight it. Then
click the Exclude option to the right. If you want to include a condition in the topic,
select its row to highlight it, then click the Include option to the right.

f. Click OK.

EXAMPLE — Snippet Level

You are writing a user guide. There is a three-step process that users need to repeat very
frequently, so you create a snippet for those steps. However, there occasionally is a fourth
step in the process, where users can optionally select an extra check box before
completing the process. You sometimes need to include this process multiple times in the
same topic, so you create a snippet for the four-step process, and apply a condition to the
optional step.
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You add your snippet to the topic...

CHAPTER 4  103



...and then exclude the snippet condition on the second instance of the snippet. By doing
this, you won’t see the optional step in that instance of the snippet.
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Later, if you need to edit the content, you only have one snippet to edit.
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EXAMPLE — Topic Level

You have a table with 15 rows and four columns. Suppose the table needs to be included in
40 topics. Rather than copying and pasting the table 40 times, you create one snippet
containing the table and insert it into those 40 topics. However, let’s say that in 30 of those
topics, you need to add three more rows to the table to explain something. In the remaining
10 topics, the three additional rows are not necessary. Otherwise, the table content is the
same in all 40 topics. What do you do? You have a few options.

The first option is to add a note to the table explaining that the three additional rows are
intended only for some of the topics but not others. However, this might be confusing to
your readers.

The second option is to create two separate snippets—one for the 30 topics and another
for the 10 topics. However, this means that you need to maintain identical information in
two different places. And that is no way to single-source your content.

The third option is to create snippet conditions. Here is how you might do it in this example:

1. Create a condition tag.

2. Open the snippet and add the necessary three rows to the table.

3. Using the table row structure bars, apply the new condition tag to the additional three
rows.

4. Use the File List window pane (View > File List) to select the 30 topics requiring the
additional rows, and open the Properties dialog.

5. Select the Snippet Conditions tab.

6. Highlight the new condition tag, and select the Include option to the right.

7. Use the File List window pane to select the 10 topics not requiring the additional
rows, and open the Properties dialog.

8. Select the Snippet Conditions tab.

9. Highlight the new condition tag, and select the Exclude option to the right.

10. After you save all of your changes and generate the target, you will notice that the
three additional rows are displayed only in the 30 topics where they were included.
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EXAMPLE — Snippet Level Overriding Topic Level

You are working in a topic that has several snippet conditions set at the topic level. When
you insert an existing snippet into your topic, you notice that some of the text in the snippet
is excluded using the condition tag Snippet1. However, the Snippet1 condition tag is also
excluded at the topic level in the topic you are working on, so that text does not appear in
the XML Editor or your output.
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Snippet conditions on individual snippets override those at the topic level. So in the topic
you right-click the snippet and choose Snippet Conditions.
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In the Snippet Conditions dialog, you set the conditions on this snippet to include Snippet1.
While Snippet1 will still be excluded at the topic level, in this particular snippet, you will be
able to see the text that is marked with that tag.
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What’s Noteworthy?

WARNING The condition feature is an inclusive system. If you do not select any options, all
of the tags will automatically be included, as indicated by the gray text in the Action cell. If
you include only some tags and exclude others, any remaining tags without options
specifically set will automatically be included. However, if you select Include for any of the
tags (even just one) and do not select Exclude for any tags, all of the other tags that do not
have the Include option set explicitly will automatically be excluded. If you have not
explicitly set an option for a condition tag, make sure you look at the gray text in the Action
cell to know what will happen for that tag in the output.

CHAPTER 4  110



TIP If you are using snippet conditions, you may want to enable snippet condition
indicators from the Show tags drop-down in the XML Editor. This command enables or
disables a marker that overlays snippets that have snippet conditions applied to them.

If you enable this indicator, you will see it on snippets if you have snippet conditions
enabled at either the topic level or the snippet level.

NOTE Remember that snippet conditions only apply to a particular instance of a snippet. If
you add new snippet conditions to an existing snippet, be sure to use the Link Viewer to
check that the content in other instances of the snippet is still visible (or hidden) the way
you want it to be.

NOTE You can generate a report to see topics in your project that contain snippet
conditions at the topic or snippet level.
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Single-Sourcing Micro Content Using
Conditions

Supported In:

The Micro Content Editor lets you work with conditions in a couple of ways for single-sourcing.

Conditions on Phrases
You can apply conditions to individual micro content phrases. This lets you separate the phrases to
be included in different outputs.

How to Apply Conditions to Phrases
1. From the Content Explorer, find and open the micro content file.

2. On the left side of the Micro Content Editor, right-click a phrase, and from the context menu
select Properties. (Alternatively, you can select the phrase and click in the local toolbar or
press F4.)

3. In the Properties dialog, select the Conditional Text tab. The first condition tag set is selected
and the associated condition tags are shown on the right.

4. If you want to see condition tags for a different condition tag set, select it.

5. For each condition tag that you want to apply to the file, click the check box next to the tag. A
check mark appears in the box.
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6. Click OK. The square next to the file name in the Micro Content Editor now takes on the color
of the condition tag. If you applied more than one condition tag to the file, each color is
shown. (If you do not see squares, click in the local toolbar.)

EXAMPLE You have two HTML5 targets in a project—one named "Target1" and the other
"Target2." In addition, you have a couple of conditions named after each of these targets.
The Target1 condition is associated with green, and the Target2 condition is associated
with orange. Each target is set to include its conditions but exclude those from the other
target.

In a micro content file called "Interface," you have five phrases. You want the phrase "file
format" to be included as micro content only in Target 1, and you want the phrase
"synchronize" to be included as micro content only in Target 2. Therefore, you apply
conditions like this.
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After building and viewing the Target1 output, you search for each of these. The "file
format" micro content displays.

But the "synchronize" micro content does not display.

Then you build and view the Target2 output. The "synchronize" micro content displays.
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But the "file format" micro content does not display.
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Micro Content Conditions
There might be times when you want to show or hide certain content depending on whether it is
viewed in a regular topic in the output or when it is viewed as micro content (e.g., in search results).
This is possible for linked responses by using micro content conditions. It is similar to the snippet
conditions feature, but is for micro content only.

How to Use Micro Content Conditions
1. Create all of the conditions that you plan to apply within micro content responses.

2. Create a micro content file and create phrases linked to responses. This can be done by
tagging content in topics as micro content, or by linking phrases from the Micro Content
Editor.

3. Apply the necessary conditions to the text or other content in the linked responses.

TIP It is a good idea to enable the Hide/Show Conditional Indicators button at the
bottom of the editor so that you can clearly see where the different tags have been
applied.

4. In the Micro Content Editor, right-click the phrase and select Properties.

5. In the Properties dialog, select the Micro Content Conditions tab.

NOTE You will not see this option if you haven't linked the phrase to a response.
Instead, you will see "Snippet Conditions," which can be applied to content entered
directly in the Micro Response Editor, just as it can be applied in a regular topic.

6. If you want to exclude a condition tag from the micro content, select its row to highlight it.
Then click the Exclude option to the right. If you want to include a condition in the micro
content, select its row to highlight it, then click the Include option to the right.

7. Click OK.

8. Click to save your work.
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EXAMPLE You have a micro content phrase called "lady bird lake," which links to part of a
topic in your project. This response includes a heading, a paragraph, and an image.

When you generate the HTML5 output and search for Lady Bird Lake, you will see all of this
content in the micro content search results. And when you open the topic, you see the
same.
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Suppose you want the image to display only in the topic, but not in the micro content
search results. Therefore, you begin by creating a condition. Let's say you name it
"TopicOnly."

In the topic where the content exists, you apply this condition to the image. A small blue
square in the upper-right corner indicates that the condition is applied.
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Next, you open the micro content file, right-click the phrase, and select Properties.
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In the dialog, you select the Micro Content Conditions tab. Then you select the
Default.TopicOnly condition row and set it to Exclude.

After you click OK and save the changes, you build the HTML5 output.
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When you open the topic in the output, you see all of the content, including the image.
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But when you search for Lady Bird Lake, you only see the heading and paragraph in the
micro content.

NOTE If you want to include content in the micro content search results, but exclude it
from the topic in the output, it is probably easier to achieve this using styles.
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Associating Conditions to a File While
Editing

When editing a document or micro content response, you can click on the left side of the local
toolbar to open the Conditional Text dialog and set condition expressions on that file or response
(i.e., include, exclude, or display by media query). This is similar to the feature that you can use to
preview a document with certain conditions set. The difference is that this associates the
conditions to the document or response as you edit it. This is not the same as applying conditions
to actual content. Nor does this feature affect the output, as do the settings in the Target Editor.
Rather, this functions more like a preview feature. It simply lets you temporarily remove from view
content that is associated with certain condition tags so that you can see how the file or response
looks without that content.
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Usually when editing, you want to see the file or response as it is intended for a particular target.
Therefore, although you can manually select conditions to include or exclude from view, the best
approach is usually to click the Target Expressions drop-down and choose a target. The condition
settings from that target are then replicated in this dialog, thus saving you time and effort.
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NOTE If you associate conditions with a file while editing and then open the Send Files For
Review Wizard, those settings are preserved. Therefore, you can quickly send the file to a
reviewer and that person will initially only see content with conditions that you have
included.

NOTE As an alternative to the condition preview button, you can click the topic preview
button to see how the topic will look with different condition and target settings.
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Removing References to Undefined
Conditions

There may be times when you have an undefined condition tag in your project. For example, you
might have a condition tag that you've applied to content and then included or excluded in some
targets. But then you delete that condition tag for some reason. In that case, there are still
references to that deleted condition tag in topics or targets, but the condition no longer exists in the
tag set, so it's considered an undefined condition tag. If this occurs and you open the Conditional
Text tab in the Target Editor (or the Properties dialog for a topic in the case of snippet conditions),
you will see a reference to that undefined condition tag in the Basic view. You can then remove the
reference to the undefined condition tag.

Undefined tags are highlighted with a colored background when "(show all tags)" is selected. You
can remove a reference to an undefined condition tag by selecting that condition row, choosing Not
Set, and saving your changes.
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A listing for "(undefined tags)" also displays in the Condition Tag Sets section. Selecting this
displays just the undefined tags.

If you select the condition tag set that the condition used to be in, you will not see the undefined
condition tag in the list.
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NOTE Even though you remove references to undefined condition tags, you may still have
topics with references to undefined conditions. You can remove the reference to that
undefined condition tag by using the Analysis Ribbon (Undefined Items > Undefined
Condition Tags). You can also use the Internal Text Editor, or remove the affected content
in the XML Editor and type it again.
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Using Conditions to Unbind Links
In addition to applying condition tags to various content in your project, you may want to use them
to unbind links from print-based output, displaying the text only.

EXAMPLE You are creating both online and PDF output from your project. You might have
some content where you have inserted hyperlinks, and you want this content to be included
in both the online and PDF output. However, let's say that a particular hyperlink connects to
another topic that you are not including in the PDF. When you generate the online output,
everything is fine. But when you generate the PDF, an error is displayed in the log because
the compiler cannot find the topic referenced in the hyperlink.

The way to avoid seeing the error (and to avoid users experiencing a broken link in the
output) is to apply a condition tag (e.g., "OnlineOnly") to the hyperlink and select the option
in the dialog to unbind the link. If you then exclude that condition tag from your print target,
you will still see the hyperlink text in the PDF, but the link will be removed. Therefore, you
will no longer receive an error and the link will not be broken.
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How to Use a Condition to Unbind a Link
1. Open the content file.

2. Make sure the span bars are visible at the top of the XML Editor. If they are not, click in the
local toolbar at the bottom of the editor to show them.

3. Right-click on the span bar above the topic that corresponds with the link.

NOTE If you first click on the link in the topic, the corresponding span bar is
highlighted above. For hypertext links, the span bar is labeled "a." For cross-
references, the span bar is labeled "MadCap:xref."

4. In the context menu, select Conditions. The Condition Tags dialog opens, with the first
condition tag set selected and the associated condition tags shown on the right.

5. If you want to see condition tags for a different condition tag set, select it.

6. Click the check box next to the tags where you want the hyperlink to remain. A check mark
appears in the box.

7. In the Exclude Action section, select Unbind.

In other words, you are telling Flare Desktop this: Keep the hyperlink in the targets that are
associated with the tags that I selected. For the targets not associated with those tags, get
rid of the hyperlink, but do not remove the text.

On the other hand, if you had selected the "Remove" option, you would have been telling Flare
Desktop this: Keep the hyperlink in the targets that are associated with the tags that I
selected. For the targets not associated with those tags, remove both the hyperlink and the
text.

8. Click OK.

9. Click to save your work.
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Viewing Used Conditions
You can view a list of all condition tags that have been applied in files throughout your project. The
list shows not only the condition tags, but each file where they have been used. You can also
quickly rename or remove multiple condition tag occurrences in a single batch.

For more information about condition tags and how they are used in projects, see the Condition
Tags Guide or the Help system.

How to View Used Conditions
1. Open a project.

2. Select Analysis > Used Items > Used Condition Tags.

3. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n Condition Tag Displays the name of the condition tag set and the tag within it. The
condition tag set is listed first, followed by a period and then the name of the condition
tag (e.g., Primary.Print).

n File Displays the name of the file.

n Title Displays the properties title of the file (if any).

n Folder Displays the folder where the file is found.

n Tag Displays the tag being used by the condition tagvariable.

n Exclude Action Displays the kind of "exclude" action tied to the condition tag. In most
cases, the exclude action is "remove." However, in some instances, this action might be
"unbind." For example, you might have the unbind action for a condition tag if you have
applied the tag to a hyperlink and want the link to be removed from the text in some
outputs, but you still want the text to be shown in those outputs.

4. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.
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NOTE You can open any file in the list to view or modify it in an editor. You can either
double-click on the specific row, or right-click on the row and select Open.

How to Rename Conditions
1. In the window pane, select all of the condition tags that you want to rename. If you want to

select all rows click . You can hold the SHIFT key to select a range, or you can hold the
CTRL key to select individual items.

NOTE All condition tags that you select will be renamed to the same condition tag
that you provide in the following steps.

2. In the local toolbar, click the Rename button. The Rename Condition tag(s) dialog opens.

3. In the New condition tag name field, enter a new name.

4. Click OK.

5. A message lets you know how many files were changed. Click OK. All of the selected
condition tags are renamed.

NOTE If you want to undo the conversions, you can use the Backups window pane
(View > Backups).
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Viewing Undefined Conditions
You can view a list of all files where you have condition tags in the content, but those condition tags
have not been defined. This might occur, for example, if you have applied a condition tag in a topic
and then later change the name of the tag or condition tag set. The old tag or set name is still used
at the location where it was previously applied in the topic. Therefore, a problem exists. From the
Undefined Condition Tags window pane, you can open the file in question and fix the undefined
condition tag. You can also quickly rename or remove multiple condition tag occurrences in a single
batch, add the undefined tag to the project, or map the undefined tag to an existing condition tag.

How to View Conditions
1. Open a project.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Analysis > Undefined Items > Undefined Condition Tags.

n Summary Window Pane Double-click the row that mentions undefined condition tags.

The Undefined Condition Tags window pane opens, displaying a list of undefined condition
tags.

3. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n Condition Tag Displays the name of the condition tag set and the tag within it. The
condition tag set is listed first, followed by a period and then the name of the condition
tag (e.g., Primary.Print).

n File Displays the name of the file.

n Title Displays the properties title of the file (if any).

n Folder Displays the folder where the file is found.

n Tag Displays the tag being used by the condition tag.

n Exclude ActionDisplays the kind of "exclude" action tied to the condition tag. In most
cases, the exclude action is "remove." However, in some instances, this action might be
"unbind." For example, you might have the unbind action for a condition tag if you have
applied the tag to a hyperlink and want the link to be removed from the text in some
outputs, but you still want the text to be shown in those outputs.
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4. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

How to Fix Undefined Conditions
There are a few different ways to fix an undefined condition tag: (1) You can rename the condition
tag or condition tag set so that it matches what you have used in the topic; (2) you can reapply the
condition tag in the topic so that it uses an existing condition tag set/condition tag; (3) you can add
the undefined condition tag to the project as a new condition tag; (4) you can map the undefined
condition tag to an existing condition tag; and (5) you can delete references in content files (e.g.,
topics, snippets) to the condition.

To Rename Conditions
1. In the window pane, select all condition tag occurrences that you want to rename. If you want

to select all rows click . You can hold the SHIFT key to select a range, or you can hold the
CTRL key to select individual items.

NOTE All condition tag occurrences that you select will be renamed to the same
condition tag that you provide in the following steps.

2. In the local toolbar, click the Rename button. The Rename Condition Tag(s) dialog opens.

3. In the New condition tag name field, enter a new condition tag. Type the name of the
condition tag set, followed by a period, then the name of the condition tag (e.g.,
Primary.Print).

4. Click OK.

5. A message lets you know how many files were changed. Click OK. All of the selected
condition tag occurrences are renamed.
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NOTE If you want to undo the conversions, you can use the Backups window pane
(View > Backups).

To Reapply Conditions
1. You can either double-click on the specific row, or right-click on the row and select Open.

2. Reapply the condition tag to the content, selecting an existing name from a condition tag set.
See the Condition Tags Guide or the Help system for more information.

To Add a Condition
1. In the window pane, select all condition tag occurrences that you want to add to the project. If

you want to select all rows click . You can hold the SHIFT key to select a range, or you can
hold the CTRL key to select individual items.

2. Do one of the following, depending on the part of the user interface you are using:

n Local Toolbar Click .

n Right-Click Right-click on the condition tag you want to add and from the context menu
select Add New Condition Tag.

The Condition Tag Set Editor opens, with the new condition tag(s) displayed.

NOTE When you create a new condition tag, one of two things will happen:

a. If the Condition Tag Set file specified exists in the project, Flare Desktop will
add the new condition tag to the existing file.

b. If the Condition Tag Set file specified does not exist in the project, Flare
Desktop will create a brand new Condition Tag Set file and add the new
condition tag to that file.
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3. (Optional) In the Condition Tag Set Editor, edit the condition tag's properties (e.g., name,
color, comment).

4. Click to save your work.

To Map a Condition
1. In the window pane, select all condition tag occurrences that you want to map to an existing

condition tag. If you want to select all rows click . You can hold the SHIFT key to select a
range, or you can hold the CTRL key to select individual items.

2. Do one of the following, depending on the part of the user interface you are using:

n Local Toolbar Click .

n Right-Click Right-click on the condition tag you want to add and from the context menu
select Map to Existing Condition Tag.

The Condition Tags dialog opens.

3. In the dialog, select the existing condition tag in the project to overwrite the current undefined
condition tag reference.

4. Click OK.

5. A message lets you know how many files were changed. Click OK. All of the selected
condition tag occurrences are overwritten with the new condition tag.

NOTE If you want to undo the conversions, you can use the Backups window pane
(View > Backups).

6. Click to save your work.
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To Delete References to a Condition
1. In the window pane, select all condition tag occurrences whose references you want to

delete. If you want to select all rows click . You can hold the SHIFT key to select a range, or
you can hold the CTRL key to select individual items.

2. Do one of the following, depending on the part of the user interface you are using:

n Local Toolbar Click .

n Right-Click Right-click on the condition tag and from the context menu select Delete.

3. Click OK.

NOTE This activity deletes the references to the undefined condition only. It does not
affect your content file(s) in any other way.

NOTE Another way to apply a different condition tag to many places throughout a project
is to use the Find and Replace in Files feature in Flare Desktop. For example, let's say that
you originally applied a condition tag named "Print" (from the "Primary" condition tag set) to
a lot of content in your project. Later, you renamed the condition tag "PDF." You can
perform a find and replace in your entire project. In the "Find" field, you can enter
Primary.Print, and in the "Replace with" field, you can enter Primary.PDF. Also, make
sure you select the "Find in source code" option in the Find and Replace in Files window
pane. After replacing this text throughout your project, that condition tag will no longer be
considered "undefined" in Flare Desktop.
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Viewing Unused Conditions
You can view a list of all condition tags that have been created in your project but have not yet been
used in any topics or other files. You can quickly delete any of the condition tags that you do not
plan to use. For more information about condition tags and how they are used in projects, see the
Condition Tags Guide or the Help system.

How to View Unused Conditions
1. Select Analysis > More Reports > Unused Items.

The Unused Items window pane opens, which lets you view various unused elements in the
project (such as bookmarks, condition tags, content files, CSH IDs, images, variables, styles,
file tags, meta tags, and topics not linked).

2. Click the drop-down field at the top of the window pane and select Unused Condition Tags.
The unused condition tags in the project are listed.

3. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n Condition Tag Displays the name of the condition tag not being used.

n File Displays the name of the condition tag set file where the condition tag is located.

4. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

5. If you want to remove any unused condition tags from Flare Desktop, as well as from the
project being analyzed, select the condition tag in the list and click in the local toolbar.

NOTE You can open the set file for any condition tag in the list to view or modify it in the
Condition Tag Set Editor.
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APPENDIX

PDFs
The following PDFs are available for download from the Help system.

Tutorials
Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Getting Started Tutorial

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Flare Online Integration
Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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